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1 Introduction to Microsoft Access  

Microsoft Access is a Relational database management system (RDBMS).  It allows the user to 

store and manipulate data.  

The main components of an Access database are:  

● Tables  

● Queries   

● Forms  

● Reports  

● Macros  

Tables overview  

Databases store data in tables.  A table is organised in rows (called records) 

and columns (called fields).  

For example, in a student table a row would store the information about one particular student.  

This called a Record.  Each column would contain details about each student such as surname, 

forename etc.  These are called fields.  

  
Figure 1 A student table  

Typically a system will consist of more than one table.  For example, in a school library the 

database might be made up of a student table, a book table and a loan table.  The student table is 

shown in Figure 1.  

Access is often referred to as a relational database.  Relationships can be defined between tables 

and used to support the searching and processing of data.  A relational database will have at least 

two tables that are linked together.  

    

Queries overview  

A query is a way of asking questions about the data in your tables according to certain criteria.  

The user may wish to display a list of appointments for a particular day or output customers who 
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ow payments.  In the example shown in Figure 2 a query has produced a list of year 11 students.  

This is known as a Select Query  

  
Figure 2 A query to select all Year 11 students  

You’ll notice that there are five records in the output from this query.  In the original table there 

were 13 records.  Five of the 13 student are in Year 11.  

Queries in Access offer a powerful processing tool.  Later you will meet actin and parameter 

queries.  Queries can also be used to take data from more than one table and perform calculations 

on data.  

Forms overview  

Forms are used mainly to display the records in a table in a user friendly way.  Through a form 

you can enter and edit records more easily.    

Forms are fully customisable.  You can add buttons and controls, edit the appearance and include 

images.  

  
Figure 3 Form  

    

Reports overview  

Reports are used to print information from your database.  They provide professional-looking 

output from a table or query.  They can be fully customised and can display summary information 

as seen in Figure 4.  
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Macros overview  

A macro is a set of one or more actions that perform a particular operation.  You can use macros to 

add buttons to print a report, open a form and other commonly used tasks.  Macros help you 

automate and customise your system.  

    
  

2 Overview of Activities  

In the next few activities you’ll be learning how to set up the tables that are needed to store the 

data for the Pass IT Driving School.  The Driving school system is based on four tables:  

• Student  

• Instructor  

• Lesson   

• Lesson Type  

There are two stages to designing tables:  

• Define the field names that make up the table and declare the data type for each  

 Set the field properties for each field name  

Defining the field names and datatypes  

Access needs to know the name of each field in each table and what sort of data to expect.  For 

example in the Student table, the Student’s telephone number might have its Field Name: TelNo.  

You also need to tell Access whether the Data Type is number, text, date/time, currency, etc. In 

this case its text  

Setting field properties  

Once you’ve named the table and defined each field with its data type, you can control the fields 

further by setting Field Properties.  These properties tell Access how you want the data stored 

and displayed.  For example a date could be displayed 19/06/2018, 19th June or 19-Jun-18.  

    

  

  

Figure  4   Extract from a report   
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3 Preparing for your activities  

3.1 Creating a folder structure  

1. Open your user area – the easiest way to do this is to open Windows Explorer and click on   

“documents”  

2. Either open your BTEC IT folder or if, you haven’t created a BTEC IT folder, create one!  

3. Either open the Unit 2 folder or, if you haven’t created a Unit 2 folder, create one.  

 

  

3.2 Creating an Access Database  

1. Load Microsoft Access (Click on the start button and type “Access” in the search bar).  You 

can see the option to open existing databases and to create new ones.  

 
  

4.   Create   a folder called “Access Training”   ( shown in  Figure  5 )   

  

Figure  5   creating folders   

2.   Double click on the  “blank desktop database”   icon 
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5. Click on OK  

  

3.   Click on the open folder icon and navigate to your “ Access Training ” folder   in your user  

area   

4.   The filename  for this Database is “ DrivingSchoo l” (notice no spaces have been used in the  
filename)   
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6. then click on Create  

When Access loads, you’ll see that a new table has already been created for you  

 

  

A database table can basically be viewed in two ways:   

  

• Design View which the structure of each table and   

• Datasheet view which shows what records are 

currently stored in each table.    

    

8. You’ll see the View icon on the left of the toolbar, click on the down arrow and 

select Design View.  

 

  

  

7.   Look at the toolbar and you’ll see the Table To ols bar.  Make sure you  select the   Fields   

tab   
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9. You’ll be prompted for the Table Name, save the table as tblStudent 10. When 

your table opens in Design View it will look something like this:  

  

  

    
4 Naming Conventions  

A naming convention is an important part of a well-built database.  We will be using naming 

conventions in our Access databases so we can easily identify the different objects in the 

database.  Your examiner will expect you to use correct naming conventions in your practical task.  

Some rules to follow:  

1. No Spaces.  Firstly, the names you use for your databases, objects (tables, queries, 

forms etc) and controls ( command buttons, list boxes etc) will not contain any spaces  

2. Prefixes.  Secondly, you’ll name your objects and controls with a prefixes.  By using a 

prefix you can more easily distinguish between different object types that have the same 

names.  i.e. if you have a table names “staff” and a report named “staff” it is difficult to tell 

which is which, so name then tblStaff and rptStaff  

Object naming conventions  

Object  Prefix  Example  

Table  tbl  tblCustomer  

Table (Lookup)  tlkp  tlkpTitle  

      

Query (Select)  qry  qryFindTotals  

      

Form  frm  frmCustomer  

Form (Subform)  fsub  fsubInvoiceLines  
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Report  rpt  rptStockList  

      

Macro  mcr  mcrUpdateStock  

      
Figure 6 Object Naming Conventions  

Controls naming conventions  

Object   Prefix  Example  

Check Box  chk   chkPaid  

Combo Box  cmb   cmbClose  

Command Button  cmd   cmdUpdatePrice  

Image  img   imgLogo  

Label  lbl   lblSurname  

Line  shp   shpLine  

List Box  lst   lstCodes  

Option Button  opt   optLanguage  

Option Group  grp   grpChoices  

Rectangle  shp   shpRectangle  

Subform  fsub   fsubParts   

Text Box  txt   txtSurname  

Toggle Button  tog   togPaid  

       

Figure 7 Controls Naming conventions  

  

5 Defining the field names and data types  
1. In your DrivingSchool database, make sure tblStudent is open in Design View  

2. In the first row overwrite ID with the Field Name: StudentID and press TAB or RETURN to 

move to the Data Type field  

3. In the Data Type field make sure AutoNumber is displayed  

4. Move to the Description field and enter Student’s ID number.  The description is optional 

but really useful to describe what will be kept in certain fields.  

5. It should look like this:  
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Figure 8 first field in tblStudent  

5.1 Primary key   

A primary key is field which can uniquely identify one and only 

one record in a database table.  Primary key are essential when 

you create relationships between tables.  You can only have one 

Primary Key in a table.  

6. You’ll notice that beside the StudentID field in Figure 8 there 

is a small key symbol, this shows that this field is the 

Primary Key for student table.  

5.2 Back to defining the field names and data types  

You are now going to continue to add Field Names and Data Types for the student table.  

7. Complete the Field Names and Data Types as shown below for the tblStudent:  

Field Name  Data Type  

StudentID (you’ve already done this one)  AutoNumber  

Title  Short Text  

Surname  Short Text  

Firstname  Short Text  

Address1  Short Text  

Address2  Short Text  

Address3  Short Text  

Address4  Short Text  

TelNo  Short Text  

DateOfBirth  Date/Time  

Gender  Text  

TheoryTestDate  Date/Time  

PassedTheoryTest  Yes/No  

PracticalTestDate  Date/Time  

PassedPracticalTest  Yes/No  

  

8. Then go to File > Save  
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5.3 Editing the table Structure   

During the course of setting up a table it is likely that you’ll make a mistake or decide to 

make a change to your table’s structure. You have a number of editing options 

available.  

5.3.1 Inserting a field  

Right click where you want the new field to go and select Insert Row or  

Go to the Table Tools > Design tab and select Insert Row  

5.3.2 Deleting a field  

Right click on the field you want to delete and select Delete Row or  

Do the same on the Table Tools > Design tab  

5.3.3 Moving a field  

Click on the row selector of the row you want to move.  The row selector is the grey bar to the left 

of the field names.  Then simply click and drag your field.  

5.3.4 Changing the Primary Key  

You can only have one Primary Key in a table so if you have set the wrong field:  

Click on the row selector (the grey bar to the left of the field names) next to the correct field, right 

click and choose Primary Key  

  

  

5.3.5 Inserting a new field for Mobile number  

9. With your tblStudent open in design view right click on the DateofBirth field name and 

select Insert row  

 
10. Give the new field the name MobileNo and set the Data type of short text  

6 Setting the field properties  

When you click on a field in Design View its field properties are displayed in the bottom half of the 

window.  In this section you are going to learn about setting the field properties.  

6.1.1 Field Properties pane  
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6.1.2 Field Properties  

The following table describes the range of field properties  

Property  Description  

Field size  This is used to fix the maximum length of any text field.  The default 

value is 255 characters.    

Format  This fixes how data can be displayed for example dates can be 

displayed in many different forms such as short date (12/12/2018) 

or long date (12 December 2018)  

Input Mask  This sets a pattern for the data to be entered into this field  

Caption  This is the field label in a form or report.  This makes using your 

database more user friendly (e.g. instead of “TimeOfLesson”, your 

user will see “Time of Lesson”  

Default value  This is the value entered into the field when the record is created.  

It is usually left blank but can be very powerful and may save your 

user time with their data entry  

Validation Rule  This defines the data entry rules.  

Validation Text  This is the error message that appears if data is invalid  

Required  This indicates whether an entry must be made  or not.  Alternatively 

you can use a IS NOT NULL validation rule  

  

Figure  9   Field Properties pane   

Field Properties pane   

When a field is  selected  

in Design view, its  

properties appear in the  

lower pane   

General tab   

The General  

tab contains  

most of the  

properties you  

will work with   

Lookup tab   

The Lookup tab is  

primarily for setting up  

lookup lists   
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Indexed   This allows data to be stored in the order of this field which speeds 

up searches  

IME Mode  Iput Method Editor, allows special character input  

IME Sentence model  Allows special character input  

    

  

6.1.3 Data Types  

Every table in Access is made up of fields. The properties of a field describe the characteristics 

and behaviour of data added to that field. A field's data type is the most important property 

because it determines what kind of data the field can store.  

Below is a list of common data types used by Access  

Data type  Explanation  

Short Text  General purpose field contain any data item made up of letters and / or 

numbers and / or characters.  Use this type for numeric entries that will not 

have calculations performed on them, such as telephone numbers  

Long Text  
Where more than 255 characters is needed to store text values  

Number  Flexible field size of 1,2,4,8 or 16 bytes.  Can also hold symbols used as 

helpers for numbers such as decimal points.  

Date/Time  
Any data item that will be a date or a time  

Currency  Decimal numbers with a currency symbol assigned to it  

AutoNumber  Use an AutoNumber field to provide a unique value that serves no other 

purpose than to make each record unique. The most common use for an 

AutoNumber field is as a primary key, especially when no suitable natural 

key (a key that is based on a data field) is available.  

Yes/No  Can only have two possible results and can be formatted to display values 

as  true/false, on/off or yes/No  

OLE Object  Can be used to show a picture or link directly to an external document  

Hyperlink  
Can be used to link a field to an external website or email address  

Attachment  Can attach multiple documents to a record  

Calculated  Calculated fields let you perform calculations with the data in your tables.  
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Lookup Wizard  Used to create a drop down box in forms later on   
Figure 10 common data types  

USEFUL LINK - https://support.office.com/en-gb/article/Introduction-to-data-types-and-fieldproperties-

30ad644f-946c-442e-8bd2-be067361987c  

    
6.2 Setting Field Properties Activity  

Using your Driving School database, you are going to go through each field in tblStudent and set 

its field properties including input masks where appropriate.  

StudentID  

1. Open tblStudent in Design View and select the StudentID field 2. 

In the Field Properties set Field Size to Long Integer  

  

Title  

6.2.1 Using the Lookup Wizard  

The Title field can only have the values Mr, Mrs, Miss and Ms.  We can use the Lookup Wizard 

whenever we want to restrict the data entered into a field to contain values  

1. Click on the Title field name  

2. In the Data Type column click on Lookup Wizard  

  
   

3. Select I will type in the values that I want and click Next  

https://support.office.com/en-gb/article/Introduction-to-data-types-and-field-properties-30ad644f-946c-442e-8bd2-be067361987c
https://support.office.com/en-gb/article/Introduction-to-data-types-and-field-properties-30ad644f-946c-442e-8bd2-be067361987c
https://support.office.com/en-gb/article/Introduction-to-data-types-and-field-properties-30ad644f-946c-442e-8bd2-be067361987c
https://support.office.com/en-gb/article/Introduction-to-data-types-and-field-properties-30ad644f-946c-442e-8bd2-be067361987c
https://support.office.com/en-gb/article/Introduction-to-data-types-and-field-properties-30ad644f-946c-442e-8bd2-be067361987c
https://support.office.com/en-gb/article/Introduction-to-data-types-and-field-properties-30ad644f-946c-442e-8bd2-be067361987c
https://support.office.com/en-gb/article/Introduction-to-data-types-and-field-properties-30ad644f-946c-442e-8bd2-be067361987c
https://support.office.com/en-gb/article/Introduction-to-data-types-and-field-properties-30ad644f-946c-442e-8bd2-be067361987c
https://support.office.com/en-gb/article/Introduction-to-data-types-and-field-properties-30ad644f-946c-442e-8bd2-be067361987c
https://support.office.com/en-gb/article/Introduction-to-data-types-and-field-properties-30ad644f-946c-442e-8bd2-be067361987c
https://support.office.com/en-gb/article/Introduction-to-data-types-and-field-properties-30ad644f-946c-442e-8bd2-be067361987c
https://support.office.com/en-gb/article/Introduction-to-data-types-and-field-properties-30ad644f-946c-442e-8bd2-be067361987c
https://support.office.com/en-gb/article/Introduction-to-data-types-and-field-properties-30ad644f-946c-442e-8bd2-be067361987c
https://support.office.com/en-gb/article/Introduction-to-data-types-and-field-properties-30ad644f-946c-442e-8bd2-be067361987c
https://support.office.com/en-gb/article/Introduction-to-data-types-and-field-properties-30ad644f-946c-442e-8bd2-be067361987c
https://support.office.com/en-gb/article/Introduction-to-data-types-and-field-properties-30ad644f-946c-442e-8bd2-be067361987c
https://support.office.com/en-gb/article/Introduction-to-data-types-and-field-properties-30ad644f-946c-442e-8bd2-be067361987c
https://support.office.com/en-gb/article/Introduction-to-data-types-and-field-properties-30ad644f-946c-442e-8bd2-be067361987c
https://support.office.com/en-gb/article/Introduction-to-data-types-and-field-properties-30ad644f-946c-442e-8bd2-be067361987c
https://support.office.com/en-gb/article/Introduction-to-data-types-and-field-properties-30ad644f-946c-442e-8bd2-be067361987c
https://support.office.com/en-gb/article/Introduction-to-data-types-and-field-properties-30ad644f-946c-442e-8bd2-be067361987c
https://support.office.com/en-gb/article/Introduction-to-data-types-and-field-properties-30ad644f-946c-442e-8bd2-be067361987c
https://support.office.com/en-gb/article/Introduction-to-data-types-and-field-properties-30ad644f-946c-442e-8bd2-be067361987c
https://support.office.com/en-gb/article/Introduction-to-data-types-and-field-properties-30ad644f-946c-442e-8bd2-be067361987c
https://support.office.com/en-gb/article/Introduction-to-data-types-and-field-properties-30ad644f-946c-442e-8bd2-be067361987c
https://support.office.com/en-gb/article/Introduction-to-data-types-and-field-properties-30ad644f-946c-442e-8bd2-be067361987c
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5. Click Next and you’ll be prompted to label your lookup field.  Using the naming conventions  

 

4.   Type in the values  Mr, Mrs,   Miss and Ms   in Col1   

  

in  Figure  6 , use the  tlkp   pref ix to name the look up like this.  Then Click Finish   
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6. In the Field Properties set the Field size to 6  

 
7. If you click on the Lookup tab you will see the screen shown below.  As you can see, you 

can easily edit the lookup values in this screen.  

 

You can specify captions for fields that are different from their actual names.  For example, if you 

have a field called “FirstName” you could set up its caption to appear as “First Name” with a space 

between the words – this is much more user friendly  

  

8. You’ll now notice that your Title field’s name has changed to tlkpTitle (shown below)    

  
9. Go to Datasheet view (make sure you save the table) and you’ll see the field name.  This is 

not how we want it to display so you are going to use a caption to fix it  

  

  

6.2.2   Field captions   
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10. Go back to Design view and click into the Title field.  Go to the properties pane and in the 

Caption box type “Title”  

 

11. Save the table and go back to Datasheet view and you’ll see a more user friendly field 

name  

Activity  

12. Now add captions to other field names to make them more user friendly  

6.2.3 Field sizes  

You can adjust the amount of space that each record in an Access table uses by changing the field size 

property of number fields in the table.  Setting a field’s size as small as possible, while still 

accommodating all entries, keeps the database file small.  The difference in file size becomes more 

pronounced as more records are stored.  

Surname, Forename, Address1 & Address2  

1. In the design view of your tblStudent, select the Field Name: Surname and set the Field 

Size to 20, repeat this for FirstName  

2. Select the Field Name: FirstName and in the Caption box type First Name  

3. Select the Field Name: Address1 and set the field size to 30, repeat this for Address2  
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6.2.4 Default Values  

You can speed up data entry for fields that usually contain the same value by making that value 

the default.    

Note:  Default values are added automatically when you add a new record.  For example in a table 

of names and addresses you might set the county field to Hampshire. Hampshire then appears 

automatically each time a new record is added and you can ither leave it of change it to something 

else.  

You can also use expressions in this field property.  Typically =Date() will return the current date 

from your PC.   

In a Library Book Loaning database, the default value for the DateOfLoan field could be se to  

=Date() and similarly for DateOfReturn, the default value could be set to =Date()+14 (assuming a 14 

day load period)  

Address3  

The Pass IT Driving School is based in Sandford.  It is likely that students will live in Sandford.  It 

will save time if you set the default value for the Address3 field to Sandford  

1. Click into the Address3 field and type Sandford in the Default value box in the Field 

Properties pane (Access will insert the speech marks around the text)  

2. Set the Field size to 20  
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6.2.5 Input masks  

An Input Mask is a database instruction which restricts or controls the type, format or amount of 

data entered into a field  

You can create an input mask to help minimise data entry errors.  Input masks provide a template 

for entering data into a field, such as a specific format for a post code or date.  

Input masks use characters to represent the types of data they will accept.  Here are the most 

commonly used characters.    

  

Common Input Mask Characters  

Character  Use  

0  Allows digits (0-9 only –  does not allow plus [+] or  minus [–] signs).   Entry is required  

9  Allows digits or spaces (does not allow plus [+] or minus [ ]– signs).   Entry is not 

required.  

#  Allows digits or spaces (spaces are removed when the data is saved) 

Allows a plus [+] or minus [-] signs. Entry is not required.  

L  Allows letters only (A-Z). Entry is required.  

?  Allows letters only (A-Z). Entry is optional.  

A  Allows letters or digits. 

Entry is required.  

a  Allows letters or digits. Entry is optional.  

&  Allows any character or a space. Entry is required.  

C  Allows any character or a space. Entry is optional.  

<  Converts to lowercase all characters that follow.  

>  Converts to uppercase all characters that follow.  

\  Causes the character immediately following to be displayed as a literal character rather 

than as a mask character. (e.g. \A is displayed as just A) (e.g. \ tells Access that the 
following character, which is a space, is literal, i.e. a space will appear at the data entry 
stage)  
  

“ “  
Characters enclosed in double quotes will be displayed literally  

Figure 11 Common Input Mask Characters  

    

Input Mask Examples  

Input Mask  Meaning  Example  

LL0000  
Forces two letters followed by four digits 

to be entered.  

e.g. AB1234  
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>LA&&” “0LL  > ensures letters are in uppercase  

L forces a letter to be entered  

A Allows letters or digits  

&& allows any character or a space  

“ “ forces there to be a space   

0 forces a digit to be entered  

LL forces to letters to be added  

Postcode  

  

e.g. GU16 7SD  

e.g. G6 8JK  

   

>LL000000L  
> ensures letters are in uppercase  

L forces a letter to be entered  

0 forces a digit to be entered  

National Insurance 
number  

e.g. NR333090B  

>L<???????????????????  
(Assuming the field size is set to 20)  

> ensures first letter is uppercase  

< ensures other letters are lowercase  

L forces a letter to be entered  

& Allows up to 19 letters to be added   

e.g. First name or 

Surname  

\00###\ 00000999  
\ (literal character) forces the first 
number to be a zero  

00 forces 2 digits to be entered  

### optional two digits or spaces  

\  (literal character) forces a space  

00000 forces five digits to be entered  

999 three optional digits can be entered.  

e.g. UK landline number  

01252 666777  

  

0207 555478  

  

\00000\ 000\ 000  \0 (literal character) forces the first 
number to be a zero  

\ (literal character) forces a space in 
the correct place  

  

  

e.g. UK mobile number  

07123 123 456  

      
Figure 12 Input Mask Examples  

  



  

 

BTEC IT Unit   2  Microsoft Access Guide   CHAPTER ONE         Page  2

1 

  

Surname and First Name   

1. In Design View, click into the Surname field and then click on 

Input Mask in the Field properties area  

2. Add the input mask >L<??????????????????? this will force 

the first letter to be capitalised (see Figure 13)    

3. Add the same input mask to the firstname field.   

4. Save the table and go into data sheet view.  Test the input 

masks by typing in a couple of made-up student names.  Did the 

first letter capitalise automatically?  

  
Figure 13 Surname Input Mask  

Address4  

The Address4 field name is the student’s post code  

1. Click on the Address4 field and set Field size to 10  

2. Click on the Input Mask box in the Field Properties pane and use the put in an 

appropriate input mask for a post code(see Figure 12 for example of input masks)  

3. Save the table and go to Datasheet view.  Test the input mask for the Address4 field  

TelNo  

1. Select the Field name: TelNo and set the Field Size to 15  

2. Use the Caption box to create a more user friendly field name appear in Data sheet view  

3. Create an Input mask using the example of UK landline in Figure 12 on page 21  

MobileNo  

1. Select the Field name: MobileNo and set the Field Size to 15  

2. Use the Caption box to create a more user friendly name  

3. Create an Input mask using the example of UK mobile number in Figure 12 on page 21  

DateOfBirth  

1. The student table uses three Date/Time fields.  We will use the Short Date format for each 

one  
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2. Select the DateOfBirth field and click on the Format box in the Field Properties pane and 

choose Short Date from the drop down list and Save the table  

6.2.6 Date Input Mask Wizard  

It is also possible to use the Input mask wizard to set a placeholder _ _ / _ _ / _ _ _ _ for each 

date entered  

3. Click in the Input Mask property box and click the three dots at the end of the row or the 

Builder icon on the Table Tools Design toolbar  

  

4. The Input Mask Wizard will appear.  Select Short Date and click Next  

  
5. A choice of placeholders is offered.  Make sure the _ (underscore) is shown and click Next 

then click Finish  

 

  

or   
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6. Save the table. Go to Datasheet view and type is a date in the DateOfBirth field – you 

should see the placeholder  

7. Finally, go to the Caption box and type in a more user friendly field name, such as Date of 

Birth  

8. For the Field Names: TheoryTestDate and PracticalTestDate please add the same Input 

Mask with placeholders and change the Caption to user friendly names  

9. Save the table  
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6.2.7 Intro to Data Validation  

Input masks help users enter the proper number and type of characters, but they cannot restrict 

the field to certain entries based on logic.  Validation rules allow you to control the values 

that can be entered into a field.  By setting validation text you can choose the message this is 

displayed if the validation rule is broken.  

Validation rule Operators  

Operator    Meaning  

<    Less than  

<=    Less than or equals to  

>    Greater than  

>=    Greater than or equals to  

=    Equals to  

<>    Not equals to  

NOT    Tests for converse values e.g. NOT > 10   (or you 

could use <=10)  

*   
  is a “wildcard” and allows any character to be 

inserted  

IN    Tests for values equal to existing members in a list. 
Comparison value must be a comma-separated list 
enclosed in brackets.   

IN(“Farnborough”,”Fleet”,”Camberley”) – will only 

allow either Farnborough, Fleet or Camberley  

BETWEEN    Test for a range of values; the two values separated 

by the AND operator  

Like    Tests a Text field to match a pattern string of 

characters. E.g. LIKE “Geo*” would allow 

Geography and Geology  etc  

#    Digit or space not required  

IS NOT NULL  

  

  An entry is required in this field.  This validation rule 

replaces the “required” option in field properties.  The 

advantage of using the IS NOT NULL rule instead of 

the “required” option is that you can add a helpful 

validation message for your users.  

IS NULL    IS NULL  means that a field can be left blank  

AND    Specifies that all parts of the validation rule must be 

true e.g. >=1 AND <10   
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OR    Specifies that some but not all parts of the validation 

rule must be true.  e.g. Left OR Right, where either 

left or right could be entered.  E.g. 0 or >100, where 

the value must either be a zero or greater than 100  
Figure 14 Validation Rule Operators  

    

Examples of validation rule and validation text  

Example of validation rule  Explanation  Possible Validation text  

>8000    Please enter a number greater than 

8000  

<18    Age of student must be less than 

20  

<>0    Enter a nonzero value  

>=0    Value must be zero or greater OR 

Please enter a positive value  

BETWEEN 0 AND 50    Please enter numbers between 0 

and 50  

“S” OR “M” OR “L”    Sizes can be only S, M and L  

<=Date()  Date() indicates today’s date  Birth date cannot be in the future  

>=Date()  Date()indicates today’s date  Booking an appointment either 

today or in the future  - cannot enter 

dates in the past  

<#01/01/2020#    Please enter dates before 2020  

IS NOT NULL  Makes this a required field.  

If you use this validation rule 

you must have “no” in the 

‘required’ field property  

Please enter your first name in this 

field  

Is Null Or Like 
"*@*.*"  

Is Null means that the 

field can be left blank OR 

(means Or!)  

* is a “wildcard” and allows 

any character to be inserted 

followed by an @ sign, 

followed by more text, 

followed by a full stop, and 

then followed by the last bit 

of text  

Please enter the email address with 
an '@' sign and the full domain  
name (for example, 

'frank@gmail.com')  
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Like “Bio*”  Text entered must start with 
Bio and end in anything.   
Such as Biology,  
Biochemistry, Biomechanics 

etc  

Please enter a course name that 

starts with Bio  

Figure 15 Examples of validation rules and text  

    

Gender  

The Gender field can only have the values ‘M’, ‘F’, ‘Other’, ‘I do not wish to say’  

1. Click in the Gender field and select Validation Rule from the Properties area and enter M 

or F or Other or I do not wish to say (Access will put the quote marks in for you)  

2. In the Validation Text Type in Gender must be M, F, Other or I do not wish to say.  

  

  

3. Set the field size for the Gender field to an appropriate amount  

4. Save the table and go to Datasheet view and test your validation rule and text.  You 

should see the validation text if you type in an invalid piece of text.    

5. It is, of course, equally possible to have used the Lookup Wizard for this field property (see 

Using the Lookup Wizard on page 15.  Have a go if you wish  

  

 PassedTheoryTest and PassedPracticalTest fields  

1. The above two fields have already been set to Yes/No field types  

2. Alter the Caption for each field to a more user friendly title  

3. Save the table  

    
7 Entering the data  

1. Open your Driving school database and in the Database window select tblStudent and 

open it in Datasheet View, you are going to enter some records.  

2. As you enter the records, you should notice the following:  

• The Student ID which is an AutoNumber field is entered automatically  
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• The title field has a drop-down box set up by the lookup table wizard  

• Data entered into the Gender field is validated and any invalid entries are rejected  

• Placeholder appear in the date fields where you have set input marks to make data 

entry easier  

• Enter data into Yes/No fields by ticking the check box  

• When you’ve entered the last field in a record, a blank record appears underneath  

• When a new record is created, The Address3 field is set to Sandford.  This can still be 

edited  

• Data is saved as soon as it is entered.  

• Navigation buttons appear at the bottom of the screen allowing you to scroll through the 

records  

  

3. Enter details of the first three students:  

  
  

  

    
8 Setting up other tables  

8.1 Importing text files   

In your practical task and for the next few activities you will need to understand how to 

import text files into a database table  

8.1.1 Importing the Instructor table  

You now need to set up a second table called tblInstructor to store the details of the instructors.  

  

1. Go to the BTEC IT study directory > Unit 2 > and find the folder called Text Files  

2. In the Text Files folder find the text file called tblInstructor, right click and select 

Download  

  

3. When the file has downloaded, open your downloads folder and move tblInstructor to  
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4. Open your Driving School database and go to the External Data toolbar  

5. Select to Import Text Files  

 
    

6. When the window appears, select Browse and find the folder in your user area where you 

saved the text file  

 

7. When you’ve found tblInstructor.txt click Open and then click OK  

8. On this screen, leave the setting as Delimited and then click Next  

your  user area Access Training folder   

  

  

  

  



  

 

BTEC IT Unit   2  Microsoft Access Guide   CHAPTER ONE         Page  2

9 

  

 
    

9. On this screen, click in the box that says “First Row Contains Field Names” and you’ll 

see the 

fieldnames move in to the grey bar.  Click Next  

  

  

10.   Do  nothing on this screen , click  Next   
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11. On this screen select “Choose my own primary key” and select InstructorID from the 

drop down.  Click Next  

 
12. On this screen, alter the name to tblInstructor by changing the first T to lower case and 

click Finish  
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13. You should now see tblInstructor in the Database Window, double click to open it  
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8.2 Setting up the Instructor table  

1. Open the tblInstructor in Datasheet view, where you should see the data you imported, 

now….  

2. Open the tblInstructor in Design view  

3. Set up the table by using the structure shown in the data dictionary below:  

  
Table Name  tblInstructor   

Description  A table showing personal details of the driving instructors   

Field Name  Data Type  
Primary 

Key (Y/N)  

Foreign  
Key (Y/N)  

  

Field Size  
(if  

applicable)  

Format/  
Input Mask  

  (if applicable)  

Validation   
(if applicable)  

  

InstructorID  AutoNumb 
er  

Y  
  

Long Integer   
  

Title  Short Text  N  

  

6  Lookup table 
values Mr, Mrs,  
Ms, Miss (see Using 
the  
Lookup Wizard  
on page 15)    

Surname  Short text  N   20   Input mask add 

an appropriate 
input mask See 
Figure 12 on 
page 21  

  

 

FirstName  Short text  N    20  • Caption First  
Name  

• Input mask add 

an appropriate 
input mask See 
Figure 12 on 
page 21  

  

  

Address1  Short text  N    30      

Address2  Short text  N    30      

Address3  Short text  N    20    Default value = 

“Sandford”  

  

Address4  Short text  N    10   Input mask add 

an appropriate 
Post Code input 
mask See  
Figure 12 on 
page 21  
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HomeTelNo  Short text      15   Input mask add 

an appropriate 

input mask See  

  

     Figure 12 on 
page 21  

 Caption:  Home 

Tel No  

  

  

MobileNo  Short text      15  • Input mask add 

an appropriate 
input mask See 
Figure 12 on 
page 21  

• Caption: Mobile 

No  

  

  This is a 

required field.  

Validation rule 

needs to be 

used to make 

sure that this 

field cannot be 

left blank.  See 

how to use IS 

NOT NULL in 

Figure 15 on 

page 26  

EmailAddres 
s  

Short text  Y  n  25   Caption: Email 

Address  
  Suitable 

validation rule 
for an email 
address (see 
below on page  
35)  

        Include suitable 

validation text 

too  

  

8.2.1 Validating email addresses  

Because email addresses vary widely in the number of characters they contain, input masks are 

not a good tool for ensuring that email addresses are entered correctly. Instead, I recommend 

using the Validation Rule and Validation Text properties.   

  

The validation rule shown below ensures that the email address is entered with one or more 

characters, then an “@” sign, then one or more characters, then a period, and then one or more 

characters. For example, tom@example.com would be allowed, but tom@example,com or 

tom@example would not. If you enter an email address that doesn’t match the validation rule, 

Access doesn’t accept the input and displays the message in the Validation Text property.  (see 

Figure 14 on page 22 Figure 15 and on page 26)  

  

 Validation Rule = Is Null Or Like "*@*.*"   

  

 Validation Text = Please enter the email address with an '@' sign and the full domain name 

(for example, 'frank@contoso.com').  

   

4. Save the table  
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8.2.2 Adding data to tblInstructor  

1. Open tblInstructor in datasheet view and the four driving instructors shown below:  

2. If your email validation rule is working you should only be able to add valid email addresses 

with an @ sign in them.  

 
3. Hopefully all your input masks and validation rules are working!  If not, go back and debug 

them.  

8.3 Setting up more tables  

8.3.1 Setting up tblLessonType  

1. The third table will be the table tblLessonType, storing details of the lessons and the costs 

of each lesson.  This is the structure  

2. Creating a table.  Go to Create toolbar and select Table Design and set up these two 

fields:  

Table Name  tblLessonType  

  

     

Description        

Field Name  Data Type  
Primary  

Key  
(Y/N)  

Foreign  
Key (Y/N)  

  

Field Size  
(if  

applicable)  

Format/  
Input  
Mask  

(if  
applicabl 

e)    

Validation  

(if applicable)  

LessonType  Short Text  Y  

  

25  

  

Caption =  
Lesson  

Type    

  

Cost  Currency  N       Add appropriate validation 
rule that only allows  
values BETWEEN 0 AND 

35 (see Figure 14 on 

page 25)  

        Add appropriate validation 

text  

  

3. Save the table as tblLessonType and go to Datasheet view  

4. Type in this data:  

Lesson type  Cost  

Introductory  £16.00  

Pass Plus  £30.00  

Standard  £24.00  
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Test   £22.00  

5. Close the tblLessonType table  

8.3.2 Importing and setting up the Lesson table  

The fourth table will be the Lesson table (tblLesson).  This is the table that links all the other tables 

together and stores details of lessons booked with the Driving School.  

6. Inserting text files.  Go to the BTEC IT study directory > Unit 2 > and find the folder called 

Text Files  

7. In the Text Files folder find the text file called tblLesson, right click and select Download  

8. When the file has downloaded, open your downloads folder and move tblLesson.txt to 

your user area Access Training folder  

 

9. You are going to import a text file with the structure of this table  

10. In your Driving school database go to the External Data tab and select to Import a Text  

 

11. The import Wizard will start up  

12. When the window appears, select Browse and find the folder in your user area where you 

saved the text file  

  

file   
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13. When you’ve found tblLesson.txt click Open and then click OK 14. In the next screen, 

select Delimited, click Next  

 

15. In the next screen, select First Row Contains Field Names.  Make sure “comma” is the 

delimiter.  Then select Next  
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16. Do nothing on this screen, just click Next  

  
    

17. On the next screen, Choose your own Primary Key and select LessonNo, click Next  
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18. Finally, alter the table name to tblLesson and click Finish and close the next window.  

 

19. You’ll now see tblLesson in the object list on the left side of your Access Database, open it 

in Design view  
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Table Name  tblLesson  

Description  This is the table that links all the other tables together and stores details of lessons 

booked with the Driving School  
 Primary  Foreign  Field Size  Format/  

Validation   
 Field Name  Data Type  Key  Key  (if  Input Mask  

(if applicable)  
 (Y/N)  (Y/N)  applicable)  (if applicable)    
LessonNo  AutoNumb 

er  
Y        

  

StudentID  Number  N  Y  Long 

Integer  
  

  

InstructorID  Number  N  Y  Long 

Integer  
   

LessonDate  Date/Time  N  N  Short Date  • Caption = Lesson 

Date  

• Input mask must 
provide a prompt 
for the short date 
(see Date Input 
Mask Wizard on 
page 23)  

  

• Validation rule so 
only today’s date 
or a date in the 
future can be 
entered (See 

Figure 15 on 

page 26)  

• Validation text – 

enter a suitable, 

user friendly, 

helpful piece of 

text  

StartTime  Date/Time  N  N  Short Time  • Caption = Start  
Time  

• Input mask must 

provide a prompt 

for a short time 

(use the Input 

Mask Wizard)  

    

LengthOfLes 

son  
Number  N  N  Long 

Integer  
  Set Default value  

to “1”  

• Set Validation rule 

as : Between 1 

and 8  

• Validation Text – 

enter suitable 

validation text  

CollectionPoi 

nt  
Short Text  N  N  Field size = 

30  
• Set default value 

to “Home 

Address”  

• Caption =  
Collection Point  

  

DropOffPoint  Short Text  N  N  Field size = 

30  
• Set default value 

to “home 

Address”  

• Caption = Drop  
Off Point  
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LessonType  Short Text  n  n  Field size = 

25  
  Caption =  

Lesson Type  

Use the Lookup 
Wizard to look up 
values from 
tblLessonType (see  
page 42 for 

instructions)  

8.3.3 Using the lookup wizard to enter values from another table  

  
20. Select  the Data Type Lookup Wizard for the LessonType field  

21. The lookup Wizard will pop up, select “I want the lookup field to get the values from 

another table or query”.  Then click Next  

  
    

22. From the next window select tblLessonType and click Next  
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24. Ignore the next window, just click Next  

  

23.   Using  the single arrow , select the  LessonType   field.  Click Next   
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25. In the next window, just check that the field is wide enough to see all the lesson types, if it’s 

too narrow, just follow the instructions on screen.  Click Next  

  
    

26. Using the correct naming convention change the name of the lookup field to 

tlkpLessonType then click Finish  
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27. You will then be prompted to save the table – say Yes.  
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